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CHAPTER 1 Overview

The Luminex Molecular Diagnostics xTAG™ Data Analysis Software for the 
xTAG™ Respiratory Viral Panel (TDAS RVP-I) provides target detection calls from 
the data obtained with the xTAG™ Respiratory Viral Panel (xTAG™ RVP Test) 
which is based upon the Universal Array Tags on Luminex® xMAP™ technology. 
Luminex xMAP technology is a bead-based array platform which utilizes Luminex 
Molecular Diagnostics' Universal Array for nucleic acid based assays. Luminex 
software creates data in the form of a Comma Separated Values (CSV) file which can 
be opened using TDAS RVP-I. By opening the CSV file created in the Luminex 
software, TDAS RVP-I detects the assay module to use, analyzes the data accordingly, 
and displays the summary calls on the screen. 

Views, Printing and Exporting
The Summary View is the main window and displays the detection calls for each 
target and sample.  It provides links and functions to display, print, and export 
analysis information. Detailed information for each sample or target can be viewed by 
selecting a sample or a target and opening a new view. All views can be printed 
individually, or as a full set of sample views or target views. Data can be exported into 
a CSV file either as summary data that consists of the target detection calls, or as 
detailed data including all data and calls. Data can also be exported to a file in PDF 
format, with options to include some or all views, and some or all samples or targets. 
The PDF export file also has the option of including graphical views of the sample 
and target data.

Detection Calls Description
To make target detection calls, the software performs calculations and compares the 
results to empirically-derived threshold values specific to each assay. The first 
comparison determines whether the assay falls within the required ranges for 
background values for each target based on a negative control sample. By default, the 
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negative control sample is the last sample read on the plate. If a background signal is 
higher than acceptable values, the assay fails and a No Call result is made for all 
samples and all targets. If the assay shows no background values higher than 
acceptable values, each sample is analyzed individually. Signal values for each target 
are analyzed using assay-specific calculations and thresholds to make the target 
detection calls. See the relevant assay-specific section for more information on how 
target detection calls are made for each assay.
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CHAPTER 2 How to Use TDAS RVP-I

This section is a brief tutorial on the xTAG Data Analysis Software for the xTAG 
Respiratory Viral Panel (TDAS RVP-I), and contains basic instructions to open a data 
file, view and analyze results, print views, and export data

Starting the Software
To start the software, double-click the TDAS RVP-I icon on your PC desktop. Enter 
a user name and password if prompted.

Opening a Data File
1. On the File menu, click Open. The Open dialog box opens. 
2. On the Files of Type menu, select All Files.
3. Select the file you want to use.

NOTE:  Ensure that you choose only files created with the Luminex 
software, using the assay-specific template described in the 
package insert. If the chosen data file does not conform to the 
format required, the software will not analyze the data. 

4. Ensure that the Analyze using the following assay message displays the correct 
assay, and that at least one target is detected. For example, the message box should 
display "xTAG Respiratory Viral Panel" when analyzing the xTAG RVP Test data. 

5. Click Open to begin the analysis step.

When the analysis step completes, the summary view displays. 

NOTE:  The software will not analyze data files where bead names are 
modified during or after the data acquisition stage, or if a 
sample name contains the double-quote character ("). 
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FIGURE 1. Open Dialog Box

Viewing Results Summary
This section describes how to view results summaries, as well as some display options.

Summary View Display
The Summary View provides a listing of the target detection calls for each sample 
based upon the data file opened. These calls are the key end-point to running xTAG 
assays. The rows include sample names along with the plate well location to provide 
unique identification of the samples which enables the data to be correlated with 
sample information from other data sources. Each subsequent column corresponds 
to an individual target. Depending on the assay, these columns may be preceded with 
a summary column, providing a list of targets for which POS calls have been made. 
Finally, the last column contains explanations for No Call if one or more cells in the 
row have a No Call, or notes relevant to the calls made. The list of possible No Call 
messages is assay-specific; for more information on the No Call explanations please 
see the relevant assay-specific section. 
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FIGURE 2. Summary View

Display Options
• Expand the column header: Double-click on the right edge of the column header 

to display the full contents of the column. 
• Change the negative control sample: Data analysis is dependent on which sample 

is set as the negative control sample. By default, the last sample read is used as the 
negative control sample. To change this default, right-click on a sample, then click 
Mark as Negative Control. When changing the negative control sample, if a Com-
plete sample data or Complete target data dialog box opens, it closes automat-
ically. TDAS RVP-I re-analyzes the data and produce new results (the new results 
depend on the negative control sample data).

File Information Bar
The file information bar contains information about the current batch: 

• File name -  name of the CSV file currently being analyzed and displayed 
• Batch name -  used to uniquely identify the Luminex batch that created the CSV 

file, 
• Date and time created -  the date and time that the CSV file was created using 

the Luminex IS software. 
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• Analyzed by -  user name of the person currently logged on to TDAS RVP-I (if 
log-on is enabled and a file has been opened)

Legend Bar
The legend bar at the bottom of the page lists the name and version of the assay 
analysis module used to analyze the data file, along with an assay-specific description 
of the colours used to distinguish the cells within the data display grid. 

Status Bar
The status bar can include additional assay-specific information to aid in the analysis 
of the target detection calls. 

Viewing Results Details
Detailed results for each sample or target can be viewed once a data file has been 
successfully opened and TDAS RVP-I displays the summary results. Two types of 
detailed views can be opened from the Summary View. A detailed view of the sample 
data provides a listing of the complete data of all targets for the chosen sample. A 
detailed view of the target data provides the complete data for all samples for a 
chosen target. Multiple windows are opened if more than one sample or target was 
selected. 

View Detailed Sample Results

NOTE:  When TDAS RVP-I is password protected, this feature is only 
available to Full Access Level users. 

TDAS RVP-I displays the summary results of an open data file. To view the complete 
result set for any sample(s), perform the following steps: 

1. Select the sample(s) from the summary view by clicking on the respective entries 
(to select more than one sample, hold down the Ctrl key; to select a continuous 
group of samples, hold down the Shift key and press the up and down arrow keys). 

2. Right-click the selection, then click Show Complete Sample Data... 

You can also double-click the Location or Sample column of a specific sample.

NOTE:  TDAS RVP-I displays complete sample results for each of the 
selected samples in a separate window. If you select multiple 
samples, multiple windows open.
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FIGURE 3. Complete Sample for Data Dialog Box

View Detailed Target Results

NOTE:  When TDAS RVP-I is password protected, this feature is only 
available to Full Access Level users. 

TDAS RVP-I displays the summary results of open data files. To view the complete 
result set for any target, right-click the column heading corresponding to the target 
you want to view complete results for, then click Show Complete target Data where 
target is the name of the target you clicked. 

NOTE:  TDAS RVP-I displays complete sample results for each of the 
selected samples in a separate window. If you select multiple 
samples, multiple windows open.
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FIGURE 4. Complete Data for Target Dialog Box

Detailed Sample View Display
Data displayed in the detailed sample view provides information used to determine 
the target detection calls for that sample. Sample data for each target is listed on 
independent rows. 

The columns displayed are dependent on the assay ran, but can be described in gen-
eral as follows:

• The first column displays the target name. 
• The second column displays the target detection calls, which are coloured accord-

ing to the legend. 
• The subsequent two columns display the raw and background signals as median 

fluorescence intensity (MFI) values. Raw signals are obtained from the original 
CSV data file opened by TDAS RVP-I. Background signals are obtained from the 
original CSV data file in the negative control well for each target. The cells are 
coloured to indicate the presence of a signal based upon the assay-specific signal 
threshold values. 

• The next two columns display the threshold values used to determine the target 
detection calls. Thresholds may have different values for each target, depending on 
the empirically derived values for an assay.

• The last column displays  explanations for the No Calls where a No Call is present. 
See the relevant assay-specific section for more detailed information on the possi-
ble calls and display features.

Double-click on the right edge of a column header to display the full contents of the 
column. 
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Use the buttons at the bottom of the window to print the view, get help, close the 
window, or close all sample windows.

Detailed Target View Display
Data displayed in the detailed target view provides information to determine target 
detection calls for all samples, for that particular target. Each row contains data for 
one sample.

The displayed columns depend on the specific target, but can be described as follows: 

• The first two columns identify individual samples by displaying their plate loca-
tions and sample names.

• The next column displays the target detection calls, which are coloured according 
to the legend.

• The subsequent two columns display the raw and background signals as median 
fluorescence intensity (MFI) values. The raw signals are obtained from the original 
CSV data file opened by TDAS RVP-I. The background signals are obtained from 
the original CSV data file in the negative control well for each target. The cells are 
coloured to indicate the presence of a signal based upon the assay-specific signal 
threshold values.

• The next two columns display the threshold values used to determine the target 
detection calls. The thresholds may have different values for each target, depend-
ing on the empirically derived values for an assay.

• The last column displays the explanations for the No Calls where a No Call is 
present. See the relevant assay-specific section for more detailed information on 
the possible calls and display features.

Double-click on the right edge of a column header to display the full contents of the 
column 

Use the buttons at the bottom of the window to print the view, get help, close the 
window, or  close all target windows. 

Printing Results Summary and Results 
Details
You can print results summary data and results details of an open data file. These 
printouts are ideal for creating hard copy reports of the target detection calls. They 
contain the same information displayed in the software window. When you print 
results details, sample or target detailed data prints one view at a time, or as selected 
sets of either sample details or target details . If you print in colour, , the colours used 
to distinguish the calls are the same as in the summary view, with alternate rows 
shaded to differentiate subsequent rows. if you print in black and white, the colours 
used to distinguish the calls are not present but the alternate row shading format is 
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maintained. Due to size and readability issues, a printout may not fit on one page. You 
should perform a print preview before printing and make any printer option changes 
as required. 

To print the summary view (after a file has been successfully opened),  on the File 
menu, click Print.

To preview the summary printout, on the File menu, click Print Preview. 

If you do not want TDAS RVP-I to scale the summary view to fit horizontally on one 
page, un-check Scale printout to fit in page width. The default-sized printout may 
print on several pages. 

If you want to print the summary view on a black-and-white printer and do not wish 
the printer to use the grayscale versions of the colours, un-check the "Send color data 
to printer" box; the printout will contain the alternate row shading format only and 
will no longer use colour to distinguish the target detection calls. 

Print Complete Sample Results

NOTE:  When TDAS RVP-I is password protected, this feature is only 
available to Full Access Level users. 

To print the complete results for one or more samples follow one of the methods 
below: 

• Display the complete results for the samples you want (as described in the Viewing 
Results Details section). Click Print in any of the resulting windows. 

•  Click on appropriate Location or Sample cell(s). To select more than one sample, 
hold down the Ctrl key; to select a continuous group of samples, hold down the 
Shift key and press the up and down arrow keys. Right-click any of the selected 
samples and choose Print Complete Sample Data. 

• On the File menu, click Print All. In the Print Items dialog box, ensure that 
Include the following Samples is checked. Click OK. If you do not want to 
select all samples, select a specific sample using the left button of your mouse. To 
select multiple samples, use the left button of your mouse in conjunction with the 
Ctrl or Shift keys. 

The first method has the advantage that you will know exactly what will be printed, 
since you have the results on display. The second method will print without displaying 
the results first, which is a faster way to get the printing done, but requires that you 
have selected only the samples that you want printed. The third method is most useful 
for quickly generating hard copy reports of all samples (and all targets, or data from 
all views). 
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Print Complete Target Results

NOTE:  When TDAS RVP-I is password protected, this feature is only 
available to Full Access Level users. 

To print the complete results for one or more targets, perform one of the following 
actions: 

• Display the complete results for the targets you want (as described in the Viewing 
Results Details section). Click Print in any resulting window.

• Right-click any cell of the target you want to print. Choose  Print Complete tar-
get Data, where target is the name of the target you have clicked on.

• On the File menu, click Print All. Ensure that the Include the following Tar-
gets checkbox is checked in the Print Items dialog box, then click OK. If you do 
not want all targets to be selected, you can select a specific target using the left but-
ton of your mouse. To select multiple targets, use the left button of your mouse in 
conjunction with the Ctrl or Shift keys. The Select All Targets button will allow 
you to select all of the targets. Note that this dialog box also allows you to print the 
Summary View and complete sample results. 

In the first method, you will know exactly what will be printed, since you have the 
results on display. In the second method, you choose a specific target to print without 
opening the detailed view display. The third method is most useful for quickly gener-
ating hard copy reports of all targets (and all samples, or data from all views). 

Print Complete Sample and Complete Target 
Results

NOTE:  When TDAS RVP-I is password protected, this feature is only 
available to Full Access Level users. 

If you do not want TDAS RVP-I to try to scale the detailed view to fit horizontally on 
one page, un-check the "Scale printout to fit in page width" box; the summary will 
then be printed in the default size (which may need several pages in width). 

If you want to print the detailed view on a black-and-white printer and do not wish 
the printer to use the grayscale versions of the colours, un-check Send color data to 
printer; the printout will contain the alternate row shading format only and will no 
longer use colour to distinguish the calls.

Exporting Results Summary
You can export summary data of an open data file to a CSV file. You can  then import 
the CSV file to any common spreadsheet program for further analysis or 
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presentation. The exported summary data contains all the data displayed in the 
summary view.

To export summary results:

1. On the File menu, click Export Summary As…
2. In the Export Summary dialog box, specify the location and file name for the 

exported data. 

Exporting Results Details

NOTE:  When TDAS RVP-I is password protected, this feature is only 
available to Full Access Level users. 

You can export detailed data from an open data file to a CSV file. The raw and back-
ground signals displayed in the detailed views, as well as calls for all samples and all 
targets are exported to one CSV file. You can then import the CSV file into any com-
mon spreadsheet program for further analysis or presentation, but it cannot be used 
by TDAS RVP-I to re-analyze the data. 

To export results details:

1. On the File menu, click Export Full Data As…
2. In the Export Complete Data dialog box, specify the location and file name for 

the exported data.

Exporting to PDF
You can export data to a PDF file once a data file has been successfully opened and 
TDAS RVP-I displays the summary results. You specify the contents of the PDF 
report through a dialog box. The PDF report can contain all or some of the following 
sets of data in tabular format: summary view data; detailed sample data; and detailed 
target data. You can also export detailed sample and target data in graphical format. 
The PDF export contains bookmarks to each individual sample and each individual 
target present in the report, as well as other analysis information as presented by 
TDAS RVP-I views. 

NOTE:  When TDAS RVP-I is password protected, only the summary 
view data can be exported by Restricted Access Level users. 
The detailed sample and target data can only be exported by 
Full Access Level users. 

Once a data file has been successfully opened, on the File menu, click Export to 
PDF to export the results to a PDF.
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NOTE:   If the Export to PDF command is grayed out, you will need 
to reinstall TDAS RVP-I allowing printer installation 
privileges. See your IT administrator if you do not have the 
appropriate privileges.

In the Export to PDF dialog box, you can select from the following options for 
exporting the data to the PDF file: 

• Include Summary includes the summary data in the PDF report. 
• Include the following Samples includes the sample data. If you do not want to 

select all samples, click on a specific sample. To select multiple samples, press the 
Ctrl key while clicking on each sample you want to include.. Select All Samples 
selects all of the samples. 

• Include histogram includes the graphical views for the sample data. 
• Include the following Targets includes the target data. If you do not want to 

select all targets, click on a specific target. To select multiple samples, press the Ctrl 
key while clicking on each sample you want to include. 

• Select All Targets selects all of the targets. 
• Include histogram includes the graphical views for the target data. 
• Browse... opens a dialog box where you specify the location and file name of the 

exported data. 

Click OK to open the PDF Page Setup dialog box. Set the following options for 
exporting the data: 

• Paper size. 
• Portrait or landscape page orientation
• Page margins
• Scale printout to fit in page width scales each view to fit horizontally on one 

page. If you un-check this option, each view is printed in the default size (which 
may print on several pages). 

• Send color data to the output makes all the colours present in the PDF report. 
If you un-check this option, the data grids  contain alternate row shading only, and 
will not use colour to distinguish the calls. 

Click OK to create the PDF report. 

Administrating User Access
Use log-on, password, and timeout functions to provide controlled access to TDAS 
RVP-I. The log-on function allows users to enter a user name for display, print and 
export purposes. The password function distinguishes between a Restricted Access 
Level user and a Full Access Level user through the use of two distinct passwords. 
The timeout option requires the user to log-on if TDAS RVP-I is idle for a set period 
of time. 
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When TDAS RVP-I is log-on enabled, users are  prompted to enter a user name when 
the software is started, if the software log-on has timed out, or when switching user 
names. 

The user name is used for display, print and export purposes,  and may be left blank. 

The user name entered to log on to TDAS RVP-I displays on the information bar 
beside the "Analyzed by" label in the summary view. It is incorporated in all printouts 
and export files. You can disable the log-on function If TDAS RVP-I is password pro-
tected, disabling the log-on function also disables password protection and the time-
out functions. 

When TDAS RVP-I is password protected, users are prompted to enter a user name 
and a password when the software is started, , if the software log-on has timed out, 
and when switching user names. Although the user name may be left blank, the user 
must enter a valid password. The password determines the level of access that the 
user has within the software. A Full Access Level user has access to summary results, 
detailed views, full data export, and administrative privileges. A Restricted Access 
Level user has access to summary results only. Passwords for the two access levels are 
set up at the time of installation or by enabling the function after the software is 
installed. A Full Access Level user may change the passwords at any time or disable 
the function completely. 

The timeout function is available only when TDAS RVP-I is log-on enabled. Users 
must log on to access TDAS RVP-I if idle for over a pre-set time. The default timeout 
is 10 minutes. You can change timeout period during an active session of TDAS RVP-
I. When TDAS RVP-I is log-on and password enabled, only Full Access Level users 
can change the timeout period. 

Enable Password-Controlled Access
Enabling password protection automatically enables the log-on function. Password 
protection may be set up at the time of installation. To enable password protection at 
a later time, select Enable Password on the Admin menu. 

In the Setup Passwords dialog box, specify Full Access Level and Restricted 
Access Level passwords. If you choose to set only a Full Access Level password, 
enter and re-enter the password in the appropriate text boxes under Full Access 
Level, leaving the Restricted Access Level password blank. You must set up a Full 
Access Level password before you can set up a Restricted Access Level password. If 
you want to give full access to all users, you should disable password protection rather 
than leaving both passwords blank. Once setup of password protection is complete, 
you are prompted to log on with a password before proceeding with TDAS RVP-I. 

NOTE:  Passwords must be  30 alphanumeric characters or less.  To 
reset passwords if the Full Access Level password is lost or 
forgotten, you must re-install TDAS RVP-I. 
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Change Passwords
 You must have Full Access Level to change passwords.

1. On the Admin menu, click Change Passwords. 
2. In the Change Passwords dialog box, enter the current Full Access Level 

password.
3. Enter the new password information. 

NOTE:  Passwords must be  30 alphanumeric characters or less. 

Disable Password-Controlled Access
 You must have Full Access Level to change passwords.

1. On the Admin menu, click Disable Password. 
2. In the Disable Password dialog box, enter the current Full Access Level 

password.

NOTE:  Disabling password protection does not disable the log-on 
function. 

Enable Log-on Function
Log-on is automatically enabled if TDAS RVP-I is password protected. To enable log-
on when TDAS RVP-I is not password protected, select Enable Log-On from the 
Admin menu. In the Log-on dialog box, enter a user name. The user name is used 
for display, print, and export options, and may be left blank by the user. 

Switch Identity
To change identity when TDAS RVP-I is log-on enabled:

On the Admin menu, click Switch Identity. The Log-on dialog or Log-on with 
password dialog opens. Enter a new user name and password, if a password is 
required. Click OK.

Disable Log-on Function
If access to TDAS RVP-I is password protected, disabling the log-on function 
disables password protection. 

To turn off log-on and password protection: 

1. On the Admin menu, click Disable Log-on. 
2. In the Disable Password dialog box, enter the Full Access Level password. 
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To turn off the log-on function if access to TDAS RVP-I is only log-on enabled, 
select Disable Log-on from the Admin menu.

Reactivate TDAS RVP-I After a Timeout
When the log-on function is enabled, TDAS RVP-I can be set to time out after it has 
idled for longer than a pre-set period of time. 

To reactivate a session: Click anywhere in the TDAS RVP-I window. The Log-on dia-
log box or Log-on with password dialog box opens. Enter a new user name and pass-
word, if a password is required. Click OK.

Change or Disable Timeout Period
If TDAS RVP-I is log-on and password enabled, only Full Access Level Users can 
change the timeout period.

To change or disable the timeout function:

1. On the Admin menu, click Options. 
2. In the Options dialog box, enter the desired timeout period in minutes. To disable 

the timeout function, enter 0 as the timeout period.

Using Command-Line Options
TDAS RVP-I provides command-line options which can be run from a DOS prompt, 
in a Windows "Run" dialog, or as part of a DOS batch file. To run command-line 
options from a directory other than the one that TDAS RVP-I is installed, add the 
TDAS RVP-I installation directory in the "PATH" environment variable. Please 
contact your system administrator for instructions on setting the "PATH" 
environment variable. 

The TDAS RVP-I features that are currently available as command-line options are: 

• launching the TDAS RVP-I graphical user interface (GUI) 
• exporting analysis results in CSV format 

Please note that some features require passwords as part of the command when 
TDAS RVP-I is password protected; refer to the Administrating user access help 
topic for more information on password protection. 

Important: The syntax for each command-line option begins with the executable 
"TDAS RVP-I", followed by a list of parameters. Parameters encased in square brack-
ets are optional. Words in italics should be replaced by the actual values when running 
the command. Characters in bold must be used as is.
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Launch TDAS RVP-I GUI
This command-line option launches the TDAS RVP-I GUI. The syntax for this 
command is: 

"TDAS RVP-I"  [filename] [-uUser] [-pPassword] [-q]

Parameters: 

filename

This is the name (including the path, if necessary) of the data file to be opened 
and analyzed by TDAS RVP-I. If TDAS RVP-I cannot find exactly one assay 
module to analyze this data file, TDAS RVP-I displays the Open dialog box and 
explains the reason why the file cannot be opened. If this parameter is not speci-
fied in the command-line, TDAS RVP-I launches without opening any data file.

-uUser

This optional parameter submits the name of the user that runs this command. 
The user name is mainly for log-on information purposes and displays on the 
TDAS RVP-I window. This parameter is ignored if log-on is not enabled.

-pPassword

This parameter submits the password for accessing TDAS RVP-I. If TDAS RVP-
I is not password protected, this parameter is ignored.

-q

This optional flag opens and analyzes the data file specified in the filename 
parameter without any user interaction. If TDAS RVP-I cannot find an assay 
module to analyze the data file, TDAS RVP-I launches without opening any data 
file. 

Export Analysis Results
This command-line option exports the analysis results as a CSV file. Please refer to 
the Exporting results summary or the Exporting results details help topic for more 
information on the content of the exported results file. The syntax for this command 
is: 

"TDAS RVP-I"  cmd  filename  -oExport_filename  [-uUser] [-pPassword] [-q]

Parameters: 

cmd

Must be one of the following commands:
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• -export
Export the summary of the analysis result. Available to users of all access levels 
when TDAS RVP-I is password protected

• -exportall
Export the details of the analysis result. Available only to Full Access Level users 
when TDAS RVP-I is password protected.

filename

This is the name (including the path, if necessary) of the data file to be analyzed 
by TDAS RVP-I. If this parameter is not specified in the command-line or TDAS 
RVP-I can not find exactly one assay module to analyze the data file, the export 
process fails.

-oExport_filename

This is the name (including the path, if necessary) of the exported file which is the 
output of this command. This parameter must be provided; otherwise, the export 
process  fails.

-uUser

This optional parameter submits the name of the user that runs this command. 
The user name is mainly for log-on information purposes and displays in the 
export file. This parameter is ignored if log-on is not enabled.

-pPassword

This parameter submits the password for accessing TDAS RVP-I. If TDAS RVP-
I is not password protected, this parameter is ignored. Note that when TDAS 
RVP-I is password protected, the -exportall feature is only available to Full Access 
Level users.

-q

This optional flag tells TDAS RVP-I to export the analyzed data without logging 
any messages to the log file.
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CHAPTER 3 Dialogs and Windows

This section of the manual describes each of the TDAS RVP-I windows. 

Most dialog boxes contain Help, OK, Cancel, Exit, or Close  buttons. They perform 
the following functions:

• Help - Opens the online help
• OK - Confirms the task you are performing.
• Cancel - Cancels the task you are performing
• Exit - Exits the current window
• Close - Closes the current window.

Unless a button behaves differently than stated above, it is not documented as part of 
the dialog box description in the following sections.

Summary View Window
The Summary View is the main window of the TDAS RVP-I software. When a file 
is open, it displays a data analysis summary. 

Menu Bar
The menu bar contains the following menus:

• File -   open or close a file, export results, view file properties, print results, or exit 
the program 

• View -  Change viewing options for the toolbar, status bar, file information bar, 
legend bar, target columns, and preferences 

• Sample -  Mark the sample as negative control, show or print complete data for 
selected sample(s) 

• Target -  Show or print the complete data for selected target(s) 
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• Admin -  Disable/enable log-on and password, switch identity, change passwords, 
or change options 

• Help -  Show the complete Help manual, or open the About TDAS RVP-I dia-
log box.

Tool Bar
The Tool bar contains the following icons:

• Open -  Opens a CSV file 
• Export Summary As ... -  Exports summary data 
• Export to PDF ... -  to export a PDF report 
• Print  -  Print summary data
• Toggle file info bar -  Toggle the information bar on or off 
• Toggle legend bar -  Toggle the legend bar on or off 
• Toggle target columns -  Toggle target columns on or off.  Only available when 

the displayed assay supports this feature
• About -  Displays the "About TDAS RVP-I" information window 

File Information Bar
• File name -  name and location of the originating CSV data file currently dis-

played 
• Batch name -  name used to uniquely identify the batch and CSV file for the cur-

rent assay data 
• Date and time created -  date and time the CSV data file was created 
• Analyzed by -  user name of the person currently logged on to TDAS RVP-I, if 

log-on function is enabled 

Data Grid
Header row(s) -  contain the names of each column header, including the location and 
sample name, names of summary columns, target names, and "Notes and 
explanations" 

Multiple sample rows -  individual rows containing the information for each sample; 
one sample per row 

Legend Bar
Legend describing the assay analysis module used to analyze the file, and the colours 
used to differentiate the call cells in the data grid 



21

Dialogs and Windows

Status Bar
Additional assay-specific information 

FIGURE 5. Summary View Window

Open Dialog Box
The Open dialog box displays when you open a file. TDAS RVP-I checks that the 
selected file conforms to the format required by the analysis assay of the xTAG RVP 
Test. This dialog displays the standard Windows options for opening a file, plus  the 
"Analyze using the following assay:" area that displays which data analysis assay will 
analyze the selected file.
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FIGURE 6. Open Dialog Box

About TDAS RVP-I Dialog Box
On the Help menu, click About TDAS RVP-I to open the About TDAS RVP-I 
dialog box. This dialog displays the TDAS RVP-I version, copyright information and 
a list of all assays installed along with their version numbers.

FIGURE 7. About TDAS RVP-I Dialog Box

File Properties Dialog Box
On the File menu, click Properties to open the File Properties dialog box. This 
dialog box displays:

•  TDAS RVP-I version used to process the file 
• The date and time the file was processed by TDAS RVP-I 
• File name (including path) 
• Information extracted from the file, such as: 
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• Date and time the data was created 

• Name and version of the device that has produced the data

• Name of the operator who created the data

• Serial number of the device that has produced the data 

• Name of the batch

• Sample events

• Heater temperature

FIGURE 8. File Properties Dialog Box

Complete Data for Sample Dialog Box
After you select a sample to view in detail, the following options are available: 

• Print - Print detailed sample data
• Close all sample data windows - Closes all open detailed sample windows.
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FIGURE 9. Complete Data for Sample Dialog Box

View and Print Complete Data Dialog 
Boxes
Use the View and Print Complete dialog boxes to select one or more targets to view 
or print detailed data.

NOTE:  This feature is available to Full Access Level users only, if 
password protection is enabled.

To open the View Complete Data dialog box, click Show Complete Data on the 
Target menu.

To open the Print Complete Data dialog box, click Print Complete on the Target 
menu 

These dialogs display the list of targets to select from. 

FIGURE 10. View and Print Complete Data Dialog Boxes
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Complete Data for Target Dialog Box
After you select a target to view in detail, the following options are available: 

• Print -  Print the detailed target data
• Close all target data windows - Closes all open detailed target windows.

FIGURE 11. Complete Data for Target Dialog Box

View Preferences Dialog Box
Change user-defined preferences in the View Preferences dialog box. To open this 
dialog box, click Preferences on the View menu. This dialog contains: 

• Fonts field - Displays Sample Text in the currently used font type.
• Change Fonts... - Opens a dialog to change the font type.
• Reset to defaults - Restores the font to the default value.

FIGURE 12. View Preferences Dialog Box
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Print Items Dialog Box

NOTE:  This feature is available to Full Access Level users only, if 
password protection is enabled.

On the File menu, click Print All to open the Print Items dialog box. 

The following checkboxes and buttons are available in the Print Items dialog box:

• Include Summary - Includes summary data in the PDF.
• Include the following Samples - Includes the selected sample data selected in 

the PDF. 
• Select All Samples - Selects all samples in the list. 
• Include the following Targets - Includes the selected targets in the PDF.
• Select All Targets - Selects all targets in the list.
• Browse - Opens a dialog box where you can select or enter a PDF file name.
• OK - Continues the export process, and opens the PDF Page Setup dialog. 

The Will result in: field displays the minimum number of pages that are printed.

FIGURE 13. Print Items Dialog Box

Export to PDF Dialog Box

NOTE:  If password protection is enabled, only Full Access Level 
Users can export detailed sample and target data. All users can 
export summary view data. If the Export to PDF command is 
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grayed out, you will need to reinstall TDAS RVP-I allowing 
printer installation privileges. See your IT administrator if you 
do not have the appropriate privileges.

On the File menu, click Export to PDF to open the Export to PDF dialog box. 

The following checkboxes and buttons are available in the Export to PDF dialog 
box:

•  Include Summary -  Includes summary data in the PDF.
• Include the following Samples -  Includes the selected sample data selected in 

the PDF. 
• Select All Samples - Selects all samples in the list. 
• Include histogram (samples) -  Includes histograms for the selected samples in 

the PDF.
• Include the following Targets -  Includes the selected targets in the PDF.
• Include histogram (targets) -  Includes histograms for the selected targets in the 

PDF. 
• Select All Targets - Selects all targets in the list.
• Browse -  Opens a dialog box where you can select or enter a PDF file name.
• OK -  Continues the export process and opens the PDF Page Setup dialog box.

The Will result in: field displays the minimum number of pages that are printed.

FIGURE 14. Export to PDF Dialog
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PDF Page Setup Dialog Box
The PDF Page Setup dialog box opens when you click OK in the Export to PDF 
dialog box.

The following items are available in the Print Items dialog box: 

• Paper Size -  Select the paper size for the PDF. 
• Orientation -  Select Portrait or Landscape.
• Margins -  Set the margins, in inches.
• Scale output to fit in page width -  Scale each data grid to fit horizontally on one 

page.
• Send color data to the output - Makes all colours display in the PDF report.
• OK -  Launches the export process.
• Cancel -  Cancels the export process.

FIGURE 15. PDF Page Setup Dialog Box

Log-On TDAS RVP-I Dialog Boxes
There are two log-on dialogs: one asking for a user name only, and one that requires a 
password. When TDAS RVP-I is not password protected, may still enter a user name 
for display, print and export purposes. When TDAS RVP-I is password protected, 
users must log on to TDAS RVP-I with a password. The specific password 
determines the level of access (initially set up at installation) that the user has for that 
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session of TDAS RVP-I. Full Access Level users may change passwords during a 
session (see “Change Passwords” on page 42.)

The Log-on dialog box displays:

• at startup of TDAS RVP-I if it is log-on enabled, 
• when TDAS RVP-I has timed out, 
• when switching identity, 
• when enabling log-on function when TDAS RVP-I is not log-on enabled or pass-

word protected.

The following items are available in the Log-on dialog box:

• User Name text box -  The user name is used for display, print and export pur-
poses and may be left blank. 

• Always show log-on dialog at startup checkbox -  Disables log-on if it is NOT 
checked. This option is only available at startup of TDAS RVP-I, and only if the 
password protection function is NOT enabled. 

• Exit TDAS -  Cancels the log-on process and exit the software. This button only 
displays at startup or timeout.

FIGURE 16. Log-on TDAS RVP-I Dialog Boxes

Setup Passwords Dialog Box

NOTE:  Use this dialog only if password protection is on.

On the Admin menu, click Enable Password to open the Passwords dialog. 

This dialog has two sections:

Full Access Level - This section sets the password for access to Full Access Level 
privileges.

• New Password: Enter the new password.
• Confirm New Password: Confirm the new password
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Restricted Access Level - This section sets the password for access to Restricted 
Access Level privileges.

• New Password: Enter the new password.
• Confirm New Password: Confirm the new password.

FIGURE 17. Setup Passwords Dialog Box

Disable Passwords Dialog Box

NOTE:  Only Full Access Level users can disable the log-on and/or 
password functions. 

On the Admin menu, click Disable Password to open the Disable Password dia-
log box. This dialog has only one text field, Current Password, in which you enter 
the current Full Access Level password.

FIGURE 18. Disable Password Dialog Box
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Change Passwords Dialog Box

NOTE:  Only Full Access Level users can change passwords.

Use this dialog box when TDAS RVP-I is password protected and you want to change 
the passwords. On the Admin menu, click Change Passwords. This dialog box has 
two checkboxes:

• Update Full Access Level Password - Check to update Full Access Level pass-
words.
• New Password: Enter the new password.

• Confirm New Password: Confirm the new password.

• Update Restricted Access Level Password - Check to update Restricted Access 
Level password.
• New Password: Enter the new password.

• Confirm New Password: Confirm the new password

FIGURE 19. Change Passwords Dialog Box

Options Dialog Box
If the Log-On function is enabled, you can set TDAS RVP-I to time out if the 
application has been idle longer than the pre-set period of time.  Only Full Access 
Level users can change the timeout period if the Password function is enabled. 

On the Admin menu, click Options to open the Options dialog box. 
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This dialog has only one text field, Timeout Period, in which you enter the desired 
number of minutes for the timeout period.

NOTE:  The default timeout period is 10 minutes. To disable the 
timeout function, change the timeout period to 0 minutes.

FIGURE 20. Options Dialog Box
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CHAPTER 4 xTAG Assays Analyzed by 
TDAS RVP-I

This section describes assay-specific analysis information for  xTAG assays, including 
explanations for assay-specific target detection calls, colour-coding, and messages.

The xTAG Respiratory Viral Panel Test consists of viral targets that are analyzed 
based on signals obtained from single hybridization probes.

The calls and data are displayed in the different views of TDAS RVP-I, which have 
the following assay-specific components: 

Possible Calls

• POS Target Detected
• NEG: Target not detected
• PRES: internal / run control  detected
• ABS: internal / run control not detected 
• No Call no call possible due to the assay-specific criteria not being met 

See “Summary View Messages” on page 34. and “Detailed View Messages” on 
page 36 for detailed lists of possible No Call messages.

The Legend bar at the bottom of the display page lists the name of the assay analysis 
module used, along with an assay-specific description of the colours used to distin-
guish the cells within the data display grid. For the xTAG Respiratory Viral Panel 
Test, there are eight legend items showing the colours used: 

• Target not detected -  Cell colour indicates that no positive signal was detected 
for the corresponding target in this sample (NEG), or that the control targets have 
the expected calls for this sample. The "Location" and "Sample" cells, as well as 
the "Notes and explanations" cell are distinguished with this colour if only NEG 
and the expected control calls were made for this sample

• Target detected - Distinguishes cells to indicate that a positive signal was 
detected for the corresponding target in this sample (POS) 
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• Call(s) not made -  Distinguishes the data cells for which a call of POS, NEG, 
PRES, or ABS could not be made, and distinguishes the "Location" and "Sample" 
cells as well as the "Notes and explanations" cell to indicate that at least one data 
cell has a No Call for this sample 

• Unexpected Control Call(s) - Distinguishes the internal or run control cells for 
which an unexpected call has been made 

• Sample has at least one target detected - Distinguishes the "Location" and 
"Sample" cells if a positive signal was detected for at least one target in this sample 
(POS) 

• Signal significant - Used only in the detailed views (not in the summary view) to 
indicate raw signal cells for which the signal is significant 

• Run control sample - Distinguishes all cells of the run control sample in the 
summary view and detailed target views (the data cells, "Location" and "Sample" 
cells, and the "Notes and explanation" cell)

• Negative control sample - Distinguishes all cells of the negative control sample 
in the summary view and detailed target views (the data cells, "Location" and 
"Sample" cells, and the "Notes and explanation" cell)

Summary View Messages
The following messages may display in the Notes and explanations column of the 
Summary View:

This well was not read by the Luminex machine 

• No data is available to process because the Luminex analyzer did not read any val-
ues in this well.

Assay failed: unexpected value(s) encountered or sample is empty for negative 
control sample

• Either an unexpected value was encountered in this sample or the sample well was 
empty. 

Assay failed: 'User cancel' message from the Luminex machine for negative 
control sample

• The Luminex analyzer was interrupted by the user when reading this sample. 

Assay failed: low bead count(s) for negative control sample 

• The bead count for at least one of the bead populations used by the kit is too low 
for the negative control. This may indicate that the readings for this well are not 
reliable. 

Assay failed: a negative control signal exceeds acceptable value 
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•  At least one of the negative control values exceeds the accepted threshold value 
which indicates that the data values for this run of the assay may be in question. 

Sample failed: unexpected value(s) encountered or sample is empty 

•  Either an unexpected value was encountered in this sample or the sample well was 
empty

NOTE:  If the "Notes" column was edited before, during or after reading, 
TDAS RVP-I may not be able to correctly interpret the messages. 

Sample failed: 'User cancel' message from the Luminex machine for this well 

• The Luminex analyzer was interrupted by the user when reading this sample well. 

NOTE:  If the "Notes" column was edited before, during or after reading, 
TDAS RVP-I may not be able to correctly interpret the messages. 

Sample failed: low bead count for internal control 

•  The bead count of the internal control is too low AND there are no POS calls 
present in this sample. This may indicate that the readings for this well are not reli-
able.

Sample failed: unexpected control call(s) 

•  Calls for internal and run controls are not acceptable call combinations. This can 
occur if the sample is not a run control sample, but the internal control target has 
an ABS call and the remaining targets do not have POS calls.

Target(s) failed: low bead count(s)

•  The bead count of one or more targets is too low. This may indicate that the read-
ings for this well are not reliable. 

Target(s) failed: value(s) not within predefined ranges 

•  The value(s) for one or more targets does not meet the predetermined thresholds 
that would allow a call of POS, NEG, PRES, or ABS to be made.

Targets failed: incompatible signals between targets 

• The signal for a particular target is not compatible with that of its reference target. 

Warning: unexpected control call(s) 

• The calls for the internal and run controls are not expected call combinations. This 
can occur if the sample is not a run control sample, but the run control target does 
not have an ABS call and/or the internal control target does not have a PRES call. 

Warning: 'Luminex message' message from the Luminex machine for this 
well 
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•  The sample analysis is performed as for a normal well, but the message warns the 
user that something unusual may have happened during the data reading process 
which may affect the results. 

NOTE:   Only the 'Sample Empty' or 'User cancel' Luminex analyzer 
messages are expected to be found. 

Detailed View Messages
This well was not read by the Luminex machine

• No data is available to process because the Luminex analyzer did not read any val-
ues in this well. 

Assay failed: unexpected value(s) encountered or sample is empty for negative 
control sample 

•  Either an unexpected value was encountered in this sample or the sample well was 
empty.

Assay failed: 'User cancel' message from the Luminex machine for negative 
control sample

•  The Luminex analyzer was interrupted by the user when reading this sample well. 

Assay failed: low bead count(s) for negative control sample 

• The bead count for at least one of the bead populations used by the kit is too low 
for the negative control. This may indicate that the readings for this well are not 
reliable. 

Assay failed: a negative control signal exceeds acceptable value 

• At least one of the negative control values exceeds the accepted threshold value 
which indicates that the data values for this run of the assay may be in question. 

Sample failed: unexpected value(s) encountered or sample is empty 

•  Either an unexpected value was encountered in this sample or the sample well was 
empty.

NOTE:  If the "Notes" column was edited before, during or after reading, 
TDAS RVP-I may not be able to correctly interpret the messages. 

Sample failed: 'User cancel' message from the Luminex machine for this well 

• The Luminex analyzer was interrupted by the user. 

NOTE:  If the "Notes" column was edited before, during or after reading, 
TDAS RVP-I may not be able to correctly interpret the messages. 
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Sample failed: low bead count for internal control 

•  The bead count of the internal control is too low AND there are no POS calls 
present in this sample. This may indicate that the readings for this well are not reli-
able. 

Sample failed: unexpected control call(s) 

•  The calls for the internal and run controls are not acceptable call combinations. 
This can occur if the sample is not a run control sample, but the internal control 
target has an ABS call and the remaining targets do not have POS calls. 

Target failed: low bead count 

•  The bead count of this target is too low. This may indicate that the readings for 
this well are not reliable. 

Target failed: value not within predefined ranges 

•  The value for this target does not meet the predetermined thresholds that would 
allow a call of POS, NEG, PRES, or ABS to be made. 

Targets failed: incompatible signals between targets 

•  The signal for a particular target is not compatible with that of its reference target. 

Warning: unexpected control call(s) 

• The calls for the internal and run controls are not expected call combinations. This 
can occur if the sample is not a run control sample, but the run control target does 
not have an ABS call and/or the internal control target does not have a PRES call. 

Warning: 'Luminex message' message from the Luminex machine for this 
well 

• The sample analysis is performed as for a normal well, but the message warns the 
user that something unusual may have happened during the data reading process 
which may affect the results. 

NOTE:  Only the 'Sample Empty' or 'User cancel' Luminex analyzer 
messages are expected to be found.
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CHAPTER 5 Common Tasks

This section of the TDAS RVP-I manual provides information on how to perform 
typical operations of TDAS RVP-I.

Note that some of these tasks are restricted to users with Full Access Level. If you 
cannot perform one of these tasks, log back in with the Full Access Level password. 

Open a Data File
On the File menu, click Open. 

Close a Data File
On the File menu, click Close. 

View Detailed Sample Results
1. Click the desired entries in the Summary View. To select more than one sample, 

press the Ctrl key while clicking. 
2. Right-click selected samples. Select Show Complete Sample Data... 

TDAS RVP-I opens a separate window for each sample you selected.. Consequently, 
if you select a large number of samples, a large number of windows opens. 

View Detailed Target Results
Once a data file has been successfully opened, TDAS RVP-I displays the summary 
results. To view the complete result set for any target, follow any of the steps below: 
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• On the Target menu, click Show  Complete Data...",  In the View Complete 
Data dialog box, select the desired target(s) and click OK.

• In the Summary View, right-click the appropriate column heading , then click 
Show Complete target Data where target is the name of the target you selected.

• In the detailed sample view, double-click on the row corresponding to the target 
for which you want to view complete data. 

Print Summary Results
On the File menu, click Print. 

Preview Print Summary Results
On the File menu, click Print Preview.  To print from the preview, click Print.

Print Complete Sample Results
Display the complete results for the samples you want. See “View Detailed Sample Results” 
on page 39.

For more printing options, see “Print Items Dialog Box” on page 26. Click Print in the 
resulting window. This method allows you to know exactly what will be printed.

Print Complete Target Results
Display the complete results for the targets you want. Click Print in the resulting 
dialog box. 

For more printing options, see “Print Items Dialog Box” on page 26.

Export Summary Results
On the File menu, click Export Summary As... In the Export Summary dialog 
box, specify the location and file name of the exported data.

Export Complete Results
On the File menu, click Export Full Data As… In the Export Complete Data 
dialog box, specify the location and the file name of the exported data. 
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Export to PDF

NOTE:   If the Export to PDF command is grayed out, you will need 
to reinstall TDAS-RVP-I allowing printer installation 
privileges. See your IT administrator if you do not have the 
appropriate privileges.

1. On the File menu, click Export to PDF. 
2. In the Export to PDF dialog box, choose your desired settings, then click OK. 

For more information about the available settings, see “Export to PDF Dialog Box” on 
page 26.

3. In the PDF Page Setup dialog box, choose your desired settings, then click OK. 
For more information about the available settings, see “PDF Page Setup Dialog Box” on 
page 28.

Change the Negative Control Sample
Right-click the desired sample in the summary view, then click Mark as Negative 
Control. 

For more information about changing the negative control, see “Display Options” on 
page 5.

View Available Assays
On the Help menu, click About TDAS RVP-I. 

Maximize the Data Display Area
To temporarily remove user interface elements: 

• On the View menu, click Status bar to toggle the status bar off.
• On the View menu, click File Information bar to toggle the File Information 

bar off.
• On the View menu, click Status bar to toggle the Status bar off.
• On the View menu, click Legend bar to toggle the Legend bar off.
• On the View menu, click Toolbar to toggle the Tool bar off. 

To reposition a toolbar (either detach it from the window and leave it floating, or 
attach it to any other window side), click the left border of the toolbar and drag it to 
another location. 

To resize a Complete sample data or Complete target data dialog box, click and 
drag on the dialog box borders. 



xTAG RVP

42

Toggle Target Columns

To display all or none of the target columns in the summary view, click on the 
toolbar.

This button is only available when the opened assay supports this feature. This display 
option has corresponding effects on the printing of the results summary and the 
exporting of the results to PDF. 

Expand Column Headers
Double-click the right edge of the column header.

Enable Password Protection
On the Admin menu, click Enable Password. In the Setup Passwords dialog box, 
specify the Full Access Level and Restricted Access Level passwords. 

NOTE:  Passwords must be 30 alphanumeric characters or less.

Disable Password Protection
On the Admin menu, click Disable Password.  In the Disable Password dialog 
box, enter the Full Access Level password. 

NOTE:  Disabling password protection does not automatically disable 
the log-on function.

Change Passwords
On the Admin menu, click Change Passwords... 

In the Change Passwords dialog box, enter the current Full Access Level 
password. 

NOTE:  Passwords must be 30 alphanumeric characters or less.

Enable Log-On
On the Admin menu, click Enable Log-on. In the Log-on dialog box, enter a user 
name. The user name is used for display, print and export purposes and may be left 
blank. 
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Disable Log-On

NOTE:  When access to TDAS RVP-I is password protected, disabling 
the log-on function also disables password protection

On the Admin menu, click Disable Log-on. In the Disable Password dialog box, 
enter the Full Access Level password.

When access to TDAS RVP-I is NOT password protected but is log-on enabled, click 
Disable Log-On on the Admin menu. 

Switch Identity
On the Admin menu, click Switch Identity. In the Log-on dialog box, enter the 
new user name and password, if required.

Change Timeout Period
On the Admin menu, click Options. In the Options dialog box, enter the desired 
timeout period. 

Disable Timeout
On the Admin menu, click Options. In the Options dialog box, enter 0 for the 
desired timeout period.

Open TDAS RVP-I GUI from Command 
Line
The syntax for launching the TDAS RVP-I GUI is:

“TDAS RVP-I filename [-uUser][-pPassword][-q]

For more information about this command-line option and its parameters, please see 
“Using Command-Line Options” on page 16.

Export Results Summary from Command 
Line
The syntax for exporting the results summary is: 



xTAG RVP

44

"TDAS RVP-I" -export  filename  -oExport_filename  [-uUser] [-pPassword] [-q] 

For more information about this command-line option and its parameters, please see 
“Using Command-Line Options” on page 16.

Export Results Details from Command Line
The syntax for exporting the results details is: 

"TDAS RVP-I" -exportall  filename  -oExport_filename  [-uUser] [-pPassword] [-q]

For more information about this command-line option and its parameters, please see 
“Using Command-Line Options” on page 16.


